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ASTRO-PHYSICS GTO QUICK START & WORKFLOW GUIDE

Congratulations on your new Astro-Physics mount!  We have compiled several examples of workflow strategies to help get 
you started with your observing program with our mounts.  The workflows in this guide are geared toward people who are 
controlling their mounts with their computers or mobile devices using third party software.  If you are new to AP mounts or 
mounts in general, we encourage you to begin with your most basic mount control programs and only add camera control,  
guiding, or observatory control programs one at a time as you become proficient with each one.  Only then, will you 
understand how they all work together.  At that point, you may develop a more individual workflow based on the software 
that you are using and their requirements. 

Please consult with the manual that came with your mount for instructions pertaining to the setup, balance and polar 
alignment specific to your mount.  We encourage you to check the Technical Support section of our website for more 
recent versions of your mount manual.  The GTOCPx manual will also provide information regarding your control box. 

Please look over the topics below and select the sections of this guide that are useful to your particular system and needs. 
In addition to the session workflows themselves, we offer guidance for the initial set up of the ASCOM V2 driver, NINA, 
Sequence Generator Pro (SGP), TheSkyX, SkySafari and Luminos.  The software setup should be done in advance of 
your observing session in the comfort of your home.

Note:  Screen shot photos may differ slightly due to software version updates.
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What is meant by “Initialization”?
In simplest terms, “initialization” is the process of giving the mount’s servo controller the information that it needs to know: 

	● Where is it? 

	● What is the time? 

	● How is it supposed to operate? 

	● It then unparks the mount and allows you to calibrate the mount’s pointing position by using a defined AP park position 
(if needed).  

The above is the information you will enter into your software (AP V2 ASCOM driver’s Setup Telescope, or APCC 
depending on which you will be using) during software installation and setup.  For keypad users, it is the information you 
will enter when you follow the “First Session with your Keypad” instructions (in the Keypad manual).  These four points are 
detailed below.

1.	 Where is it? Latitude and longitude coordinates tell the mount where it is.  The GTOCP4/5 will remember where it was 
when last powered down, but it can’t know if you have moved to a new location (or moved the mount’s pointing position 
by hand via loosening the clutches) unless it is told.

2.	 What is the time? Time, date and time zone give the mount the necessary time information.   Time information is 
required to calculate the mount’s current pointing position if it hasn’t been moved, and it is needed to calculate the 
meridian and the horizons.  The mount does not maintain time between power-ups, so time is an essential part of every 
initialization.

3.	 How is it supposed to operate? Commands to establish the tracking, guiding, centering and slew rates along with other 
similar parameters like PEM tell the mount how it should operate. 

4.	 It then unparks the mount - The command to “unpark” the mount is sent.  This command both ends the parked state 
and it also calculates the mount’s current pointing position if the mount has not been moved manually by hand via loos-
ening the clutches.  The decision whether or not to calibrate on a defined AP park position will depend on the circum-
stances.   

a)	 For an established setup that has not been moved since it was last initialized, do NOT calibrate on a park position.  
Resume from last parked or last position.  The unpark command will have resulted in extremely accurate calculation 
of the current pointing position without further calibration being necessary.  

b)	 For new setups, or if you have moved the mount with the clutches, you will need to calibrate on (aka “resume from”) 
one of the defined AP park positions.  
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QUICK START SUMMARY – NEW INSTALLATIONS using Keypads
This summary gives an outline of the workflow to have a successful first observing session.  Enjoy!

1.	 Enter the Time and Location data into the Keypad.  Follow the instructions in the Keypad Manual for entering your Time 
and Location data into the Keypad.  Location 1 is generally chosen as your primary observing location.

2.	 Set the Keypad to AutoConnect: NO.  This will allow you to choose the location for which you entered the data above.  
Remember to power cycle the mount after the data has been entered.  This will lock the information.  

3.	 Assemble the mount.  Reference your Mount Manual.

4.	 Balance the system.  Reference your Mount Manual.

5.	 Polar align the mount – at least roughly.  If using the daytime routine, move this step to after the mount is initialized.  If 
using the RAPAS, do this before initializing the mount.

6.	 Place the system into a pre-defined AP Park position for initialization.  Reference the AP Park positions shown at the 
end of this Quick Start Guide.  

7.	 Power up the mount; select your location and press GoTo.  

8.	 The next menu has 4 choices.  Choose “4=New Setup” and select the Park position that you chose in Step 6 above.   
This will initialize the mount and ready it for going to your first object. 

9.	 When you arrive at your first object you may need to use the N S E W buttons to center the object.  Do so and then 
press the RA DEC REV button on the bottom right, followed by the #9 button to do a ReCal of position.  The following 
GoTo slews to other objects should be more accurate.  

10.	After finishing your night’s observing (or day’s solar observing), park the mount into your desired Park position by 
pressing 2=Setup; then 4=Park / Mount Opt.; and then choose the Park position number where you wish to park at.

11.	Power down the mount. 

Helpful Hints
	● “New Setup” is only used when you are setting up the mount for the first time or if you have readjusted scope position 

via the clutches and wish to restart from a “Reference Position”. 

	● “ResumeLastPosition” is used when you parked the mount at the end of the previous session and wish to begin a new 
night of observing.  Selecting it will initialize the mount and you’ll be ready to go to your first object.

	● If you are in a permanent setup, then you should set the Keypad to “AutoConnect: YES” so that when you power up 
the mount, it will automatically be initialized and ready to go to your first object.  This is the most automated of the 
setups using the Keypad. 

What If I Get Lost?
 
Hope is not gone...there is a very quick and easy fix!

1.	 Loosen all the R.A. and Dec. clutches so that the scope can be moved freely with your hands.  Move the scope to Park 
3 position. Moving the scope into a Park 3 position will provide additional safety for this procedure.  

2.	 Command the mount to go to Park 3 using either the Keypad or a computer (whichever you have been using for the 
evening).  While the motors are moving, hold the scope with your hands so that it remains safe. 

3.	 When the motors both stop, use your hands and put the scope into Park 3 (use your eyes to get close) and then tighten 
all the clutches.  Newer mounts can use the alignment marks for accuracy. 

4.	 That’s it...you’re done!  Orientation has been restored to the universe!  When you go to your first object you’ll need to 
tweak the centering and do a ReCal, but you’ll be close.  
 
For Mach2 mounts, the above steps do not apply. You only need to press the +/- button, then “Slew Home & Sync”
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QUICK START SUMMARY – NEW INSTALLATIONS using Computers
 
This summary gives an outline of the workflow to have a successful first observing session.  Enjoy! 
	 (Note:  Your Keypad should either not be connected or should be set to AutoConnect: EXT)

1.	 Install and set up your control software and drivers.  This can be done before you even take delivery of your mount.  As 
a note, your software programs should all run with the same user privileges, and not be set to “run as administrator”.  

a)	 Set up ASCOM platform and the drivers.

i)	 ASCOM Platform 6.6SP2 or newer - the latest version is always available at https://ascom-standards.org/. 

ii)	 AP V2 ASCOM driver - the latest version is always available at http://www.gralak.com/apdriver. 

iii)	 FTDI driver - available from the  Astro-Physics Software Updates page - https://www.astro-physics.com/soft-
ware-updates/. (this is only required if you are using the USB connection on your control box.) 

b)	 Install any third party control software (NINA, Sequence Generator, TheSkyX, MaxImDL, Starry Night, etc.). 

c)	 Adjust software settings - follow the relevant Workflow documentation described in this guide.

d)	 If using the Keypad along with computer control software, set the Keypad to AutoConnect=EXT and power cycle the 
mount in order to lock in the change (if needed, refer to the Keypad manual for details on how to set this).

2.	 Assemble the mount.  Reference your Mount Manual.

3.	 Balance the system.  Reference your Mount Manual.

4.	 Polar align the mount – at least roughly.  If using the daytime routine, move this step to after the mount is initialized.  If 
using the RAPAS, do it before initializing.

5.	 Place the system into a pre-defined AP Park position for initialization.  Reference the positions shown at the end of this 
Quick Start Guide.  We generally recommend Park 3 as a good starting park position.

6.	 Power up the mount and connect with your primary control software.  Use the primary control software to initialize 
the mount.   Start out from the park position chosen in #5 above.   Your other initialization settings will have been set 
already in step #1.

a)	 If using APCC, always start it and connect APCC to the mount first.

b)	 If only the AP V2 Driver is being used, it will be started when a client program connects to the mount. 

7.	 Connect other software that you will use with the mount.

8.	 After finishing your night’s observing (or day’s solar observing) park the mount using either APCC or the Third Party 
software if you are using a PC for mount control. 

9.	 Power down the mount. 

What If I Get Lost?
Hope is not gone...there is a very quick and easy fix!

1.	 Loosen all the R.A. and Dec. clutches so that the scope can be moved freely with your hands.  Moving the scope into a 
Park 3 position will provide additional safety for this procedure.  

2.	 Command the mount to go to Park 3 using either the Keypad or a computer (whichever you have been using for the 
evening).  While the motors are moving, hold the scope with your hands so that it remains safe. 

3.	 When the motors both stop, use your hands and put the scope into Park 3 (use your eyes to get close) and then tighten 
all the clutches.  Newer mounts can use the alignment marks for accuracy. 

4.	 That’s it...you’re done!  Orientation has been restored to the universe!  When you go to your first object you’ll need to 
tweak the centering and do a ReCal, but you’ll be close.  
 
For Mach2 mounts, the above steps do not apply. You only need to click “Find Home” under APCC’s AE tab. 
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Workflow When Using the AP V2 Driver with Third Party Software 
(examples: Starry Night, MaxImDL, Sequence Generator Pro, etc.) 

1.	 Be sure that you first install the current ASCOM Platform and AP V2 ASCOM driver.  Having all software and drivers 
current is important in order to avoid connectivity issues.  

a)	 ASCOM Platform 6.6SP2 or newer - install first 
http://ascom-standards.org/index.htm . 
 
Click on the download button and install the full download.  
Once the download is complete you are done.  There are no 
additional settings to make to the platform.  See arrow.  

b)	 Astro-Physics V2 ASCOM driver - install second 
http://www.gralak.com/apdriver . 
 
Detailed information regarding setting up the AP V2 ASCOM driver is located within these instructions.  Please 
check frequently to ensure that you are using the current version of this driver.  Important updates and bug-fixes are 
made periodically to ensure that your mount functions safely.   
 
Helpful Hint:  Clicking on the “?” in the upper right corner of each window in all the screens found in both the AP V2 
driver and APCC will immediately jump you to that specific section of the Help Menu!

2.	 Open the “Setup Telescope” in the AP V2 driver and enter the required settings.  Reference the section that follows 
entitled “Setting Up the Astro-Physics V2 ASCOM Driver”.

3.	 Install your third party software.

4.	 Locate the Telescope Chooser or Settings in the third party control software - all ASCOM compliant software will have a 
chooser or settings drop down menu.

5.	 Select the AP V2 driver.  The driver will be called  “Astro-
Physics GTO V2 Mount”.  See image at right. 
 
Once you select it you may be asked to click “Proper-
ties...”.  When you click “Properties...” you will be shown 
the AP V2 driver’s “Setup Telescope” window that you 
filled out earlier.   You can review and modify if you wish.  
Then click “OK” once or twice and you are done.   
 
The Astro-Physics V2 ASCOM driver is a hub through 
which all third party ASCOM compliant software connects.  
Planetarium, camera control and focusing software, etc. 
can all be connected to it simultaneously.  

6.	 Place the mount / telescope system into a defined AP park 
position.  See the section in the mount manual illustrating 
Park Positions.  

a)	 If you are setting up the mount afresh (as when you need to disassemble the mount each night), you will tell the 
mount to unpark from a specific Park position (for example Park 3).

b)	 If you simply park the mount each night (in an observatory or at a multi-night star party), then you will always unpark 
from “Last Parked”.  This assumes that you have not loosened the clutches and moved the telescope by hand.

7.	 Power up the mount.  

8.	 Start your control software and have it connect to the mount.  It will start the AP V2 driver which will initialize the mount. 

9.	 After finishing your night’s observing (or day’s solar observing) park the mount to your chosen Park position. 

10.	Disconnect and close the active software programs (the AP V2 driver will close automatically).

11.	Power down the mount.  
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Workflow When Using APCC & the AP V2 Driver with Third Party Software 
	 (examples: Starry Night, MaxImDL, Sequence Generator Pro, etc.) 

1.	 Be sure that you first install the current ASCOM Platform and AP V2 ASCOM driver.  Having all software and drivers 
current is important in order to avoid connectivity issues.  

a)	 ASCOM Platform 6.6SP2 or newer - install first 
http://ascom-standards.org/index.htm . 
 
Click on the download button and install the full download.  
Once the download is complete you are done.  There are no 
settings to make.  See arrow.

b)	 Astro-Physics V2 ASCOM driver - install second 
http://www.gralak.com/apdriver . 
 
Detailed information regarding setting up the AP V2 ASCOM driver is located within these instructions.  Please 
check frequently to ensure that you are using the current version of this driver.  Important updates and bug-fixes are 
made periodically to ensure that your mount functions safely

c)	 Astro-Physics Command Center (APCC) - install third  
 
Please refer to the APCC Installation and Getting Started Quick Guide (PDF) located in the same section of our 
website as the APCC download files.  We suggest that you download this PDF and the full manual for future refer-
ence. 
 
Helpful Hint:  Clicking on the “?” in the upper right corner of each window in all the screens found in both the AP V2 
driver and APCC will immediately jump you to that specific section of the Help Menu!

2.	 Open the “Setup Telescope” in the AP V2 driver and enter the required settings.  Reference the section that follows 
entitled “Setting Up the Astro-Physics V2 ASCOM Driver”. 
 
Important:  We have made setting up APCC with the AP V2 ASCOM driver much easier through the addition of 
APCC’s “Configure Driver” button.  Clicking this button will automatically configure the V2 driver, allowing APCC to take 
full control of the driver settings.  Just click and forget.  This will be discussed in more detail in the section “Setting Up 
Astro-Physics Command Center (APCC)” later in this document.

3.	 Install your third party software.

4.	 Locate the Telescope Chooser or Settings in the third party control software - all ASCOM compliant software will have a 
chooser or settings drop down menu for Mount selection (also sometimes referred to as Telescope selection).

5.	 Select the AP V2 driver.  The driver will be called  “Astro-
Physics GTO V2 Mount”.  See image at right. 
 
Once you select it you may be asked to click “Proper-
ties...”.  If you click “Properties...” you will be shown the 
AP V2 driver’s “Setup Telescope” window that you filled 
out earlier.   You can review it if you wish.  Then click “OK” 
once or twice and you are done.   
 
The Astro-Physics V2 ASCOM driver is a hub through 
which all third party ASCOM compliant software can be 
connected.  Planetarium, camera control and focusing 
software, etc. can be connected to it and operated simul-
taneously.  

6.	 Place the mount / telescope system into a defined AP park 
position.  See the section in the mount manual illustrating Park Positions.  

a)	 If you are setting up the mount afresh (as when you need to disassemble the mount each night), you will tell the 
mount to unpark from a specific numbered position (for example Park 3).

b)	 If you simply park the mount each night (in an observatory or at a multi-night star party), then you will always unpark 
from “Last Parked”.  This assumes that you have not loosened the clutches and moved the telescope via hands.



7

7.	 Power up the mount.  

8.	 Start APCC first and have it connect to the mount.  APCC will be the software that initializes the mount with the settings 
that you have set in APCC.  

9.	 Start your third party software and connect it to the mount.  The third party software will automatically start the ASCOM 
V2 driver which will then automatically connect to APCC. You are now ready to enjoy the evening.  

10.	After finishing your night’s observing (or day’s solar observing) park the mount to your chosen Park position. 

11.	Once the mount is parked disconnect and close the active third party software. Closing third party software will auto-
matically close the AP V2 driver.

12.	Close APCC. 

13.	Power down the mount. 

Important note:  If you are starting the mount and initializing from APCC, then it will override any 
settings defined in the AP V2 ASCOM driver (if different than APCC’s settings).
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Workflow When Using TheSkyX with the AP V2 Driver 

1.	 Be sure that you first install the current ASCOM Platform and AP V2 ASCOM driver.  Having all software and drivers 
current is important in order to avoid connectivity issues.    

a)	 ASCOM Platform 6.6SP2 or newer - install first 
http://ascom-standards.org/index.htm . 
 
Click on the download button and install the full download.  
Once the download is complete you are done.  There are no 
settings to make.  See arrow.

b)	 Astro-Physics V2 ASCOM driver - install second 
http://www.gralak.com/apdriver  
 
Detailed information regarding setting up the AP V2 ASCOM driver are found within these instructions.  Please 
check frequently to ensure that you are using the current version of this driver.  Important updates and bug-fixes are 
made periodically to ensure that your mount functions safely. 
 
Helpful Hint:  Clicking on the “?” in the upper right corner of each window in all the screens found in both the AP V2 
driver and APCC will immediately jump you to that specific section of the Help Menu!

2.	 Open the “Setup Telescope” in the AP V2 driver and enter the required settings.  
Reference the section that follows entitled “Setting Up the Astro-Physics V2 
ASCOM Driver”.

3.	 Install TheSkyX and any other third party software.

4.	 In TheSkyX go to “Telescope” in the menu bar and locate the Telescope Chooser 
in the drop-down menu.  Then select ASCOM Mount.  See image at right. 
 
Important Note:  Do NOT select Astro-Physics from that list.  The listed mounts 
are TheSkyX native drivers and NOT the Astro-Physics ASCOM driver.  They will 
NOT connect through ASCOM and the AP V2 driver, nor through APCC; conse-
quently, you will not be able to take full advantage of the functionality, precision 
and safety that is available through our software.  

5.	 Go back to the drop-down menu and select “Settings”.  It will open the ASCOM Telescope Chooser and you will select 
“AstroPhysics GTO V2 Mount”.  See image below right.

6.	 Once you select it you may be asked to click “Properties...”.  If you click “Properties...” you will be shown the AP V2 
driver’s “Setup Telescope” window that you filled out earlier.   You can review it if you wish.  Then click “OK” once or 
twice and you are done.  

The Astro-Physics V2 ASCOM driver is a hub through which all third party ASCOM compliant software connect.  
Planetarium, camera control and focusing software, etc. connect and operate simultaneously through this driver.  

7.	 Place the system into a defined AP park position.  See the section, Pre-De-
fined Park Positions, at the end of this Quick Start Guide.

a)	 If you are setting up the mount afresh (as when you need to disassemble 
the mount each night), you will tell the mount to unpark from a specific 
numbered position (for example Park 3).

b)	 If you simply park the mount each night (in an observatory or at a multi-
night star party), then you will always unpark from “Last Parked”.  This as-
sumes that you have not loosened the clutches and moved the telescope 
via hands.

8.	 Power up the mount and then start TheSkyX.  When TheSkyX connects to the mount it will start the AP V2 driver which 
initializes the mount. 

9.	 After finishing your night’s observing (or day’s solar observing) park the mount to your chosen Park position. 

10.	Disconnect and close the active software programs (the AP V2 driver will close automatically).  Power down the mount.

Select
Choose

Select
ASCOM Mount

not
Astro-Physics

Select
Settings
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Workflow When Using TheSkyX with Native Drivers 

NOTE: We do not recommend using TheSkyX with Native Drivers. Instead, use the ASCOM AP V2 Driver described 
in the prior section. Details on native drivers are provided for legacy reference only.

Note:  This should also apply when using TheSkyX with native 
drivers on a Mac. However, this is based on Software Bisque 
documentation: Astro-Physics has not confirmed this compatibility 
on a Mac.    

1.	 Install TheSkyX and any other third party control software.

2.	 Go to “Telescope” in the menu bar and locate the Telescope 
Chooser in the drop-down menu.  Then select Astro-Physics and 
the appropriate mount type.  See image at right.

3.	 Connect the computer to the mount using any of the four con-
nection options (USB, Serial, Ethernet or WiFi).  If using USB or 
serial connection, open your computer’s Device Manager and 
see which COM port is being used or available.  

4.	 Go back to “Telescope” in the menu bar and locate the Tele-
scope Settings in the drop-down menu.  Be sure that the correct 
COM port has been chosen.

5.	 Power up the mount and start TheSkyX.  

6.	 Open the Telescope tab and click on the Start Up drop-down menu.  Select and click Connect Telescope.  

7.	 Locate a bright star that you recognize about 40 to 60 degrees up from the east or west horizon.  Manually center the 
star, either by loosening the mount’s clutches and pushing the scope by hand, or using move buttons or with the Key-
pad direction buttons.

8.	 Find the star in TheSkyX’s planetarium field and click on it or 
right-click the field and select Find.  In the Start Up menu click 
Star Synchronization.  Click the Sync button.  You are now 
ready to enjoy your night.  See image below.

9.	 After finishing your night’s observing (or day’s solar observ-
ing) it is best to park the mount by selecting Park in the above 
mentioned Shut Down menu..  Note:  Establish a park position 
by going to a position of convenience for parking and set it with 
Set Park Position in the Telescope Tab’s Shut Down drop-down 
menu (this can be done prior to finishing your evening).    

10.	Disconnect and close the active software programs.  

11.	Power down the mount. 

Important Note:  If you encounter a problem using TheSkyX native drivers, you will need to contact Software Bisque for 
support.  This will be especially true when operating with a Mac.  We may be able to help with some minor problems, but 
Software Bisque will be the best source for addressing issues with their software.

Select
Choose

Select
Astro-Physics

Mount
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Workflow When Using NINA with APCC & the AP V2 Driver
1.	 Be sure that you first install the current ASCOM Platform and AP V2 ASCOM driver.  Having all software and drivers 

current is important in order to avoid connectivity issues.    

a)	 ASCOM Platform 6.6SP2 or newer - install first 
http://ascom-standards.org/index.htm . 
 
Click on the download button and install the full download.  
Once the download is complete you are done.  There are no 
settings to make.  See arrow.

b)	 Astro-Physics V2 ASCOM driver - install second 
http://www.gralak.com/apdriver  
 
Detailed information regarding setting up the AP V2 ASCOM driver are found within these instructions.  Please 
check frequently to ensure that you are using the current version of this driver.  Important updates and bug-fixes are 
made periodically to ensure that your mount functions safely. 
 
Helpful Hint:  Clicking on the “?” in the upper right corner of each window in all the screens found in both the AP V2 
driver and APCC will immediately jump you to that specific section of the Help Menu!

2.	 Open the “Setup Telescope” in the 
AP V2 driver and enter the required 
settings.  Reference the section that 
follows entitled “Setting Up the Astro-
Physics V2 ASCOM Driver”.

3.	 Install NINA

4.	 Go to “Equipment” in the left icon bar 
and locate “Mount”.  

5.	 From the drop-down menu select 
“AstroPhysics GTO V2 Mount”.  See 
image right.

6.	 Once you select it you can click the Gears icon to the right of the mount selection drop-down. This will show the AP V2 
driver’s “Setup Telescope” window that you filled out earlier.   You can review it if you wish.  Then click “OK” and you 
are done.  

The Astro-Physics V2 ASCOM driver is a hub through which all third party ASCOM compliant software can be connected.  
Planetarium, camera control and focusing software, etc. can be connected to it and operated simultaneously.  

7.	 Place the system into a defined AP park position.  See the section, Pre-Defined Park Positions, at the end of this Quick 
Start Guide.

a)	 If you are setting up the mount afresh (as when you need to disassemble the mount each night), you will tell the 
mount to unpark from a specific numbered position (for example Park 3).

b)	 If you simply park the mount each night (in an observatory or at a multi-night star party), then you will always unpark 
from “Last Parked”.  This assumes that you have not loosened the clutches and moved the telescope via hands.

8.	 Power up the mount and then start NINA.  When NINA connects to the mount it will start the AP V2 driver which in term 
will launch APCC and initialize the mount. 

9.	 After finishing your night’s observing (or day’s solar observing) park the mount to your chosen Park position. 

10.	Disconnect your equipment in NINA and close any active software programs (the AP V2 driver will close automatically).  
Power down the mount.
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Advanced NINA Integration and Resources

The Astro-Physics Tools plug-in
The Astro-Physics Tools plugin makes it easy to connect NINA with Astro-Physics mounts. It works with APCC Pro and 
APPM to help create accurate sky models for better tracking and alignment during imaging sessions. 
 
Key Functions:

1.	 Model Creation: Automatically create all-sky and declination arc models for precise mount alignment. 
Advanced Sequencer 

2.	 Integration: Seamlessly incorporate model creation into NINA’s sequencing workflow for efficient session planning.

3.	 Expanding and automating Park positions: Send your AP mount to various Park positions and included this in your 
sequence.

Where to Download
1.	 Open NINA and go to the Plug-in Manager.

2.	 Find “Astro-Physics Tools” under the ‘Available’ 
tab.

3.	 Click “Install” and restart NINA..

Basic Usage
1.	 NINA 2.x, or 3.x and later with the SGP Server 

Emulation plugin installed and enabled.

2.	 Verify that your APCC Pro license includes the NINA Camera Support and Dec Arc Tracking features.

3.	 After installing the plugin, access its options via Plugins > Installed > Astro-Physics Tools in NINA.

4.	 Configure the plugin settings as needed, such as enabling the SGP Server Emulation plugin if using NINA 3.0 or later 
(SGP Server emulation plug-in is also available through NINA’s Plug-In Manager).

5.	 In NINA’s Advanced Sequencer, add the desired Astro-Physics Tools instructions (e.g., ‘Create Dec Arc Model’) to your 
sequence to automate model creation during your imaging session. For detailed guidance and advanced configuration 
options, refer to the official documentation on Dale Ghent’s website https://daleghent.com/astro-physics-tools

Additional Resources
There are additional resources to learn more about NINA integration with Astro-Physics mounts: 

	● Astro-Physics Tool Plug-in video overview by the author: https://youtu.be/JMcEd1_FpjI 

	● YouTube video on using the plug-in to create dec arc modeling: https://youtu.be/wL-hpGQxCGw
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Workflow When Using Sequence Generator Pro (SGP) with APCC & the AP V2 Driver
1.	 Be sure that you first install the current ASCOM Platform and AP V2 ASCOM driver.  Having all software and drivers 

current is important in order to avoid connectivity issues.    

a)	 ASCOM Platform 6.6SP2 or newer - install first 
http://ascom-standards.org/index.htm . 
 
Click on the download button and install the full download.  
Once the download is complete you are done.  There are no 
settings to make.  See arrow.

b)	 Astro-Physics V2 ASCOM driver - install second 
http://www.gralak.com/apdriver  
 
Detailed information regarding setting up the AP V2 ASCOM driver are found within these instructions.  Please 
check frequently to ensure that you are using the current version of this driver.  Important updates and bug-fixes are 
made periodically to ensure that your mount functions safely. 
 
Helpful Hint:  Clicking on the “?” in the upper right corner of each window in all the screens found in both the AP V2 
driver and APCC will immediately jump you to that specific section of the Help Menu!

2.	 Open the “Setup Telescope” in the AP V2 driver and enter the required settings.  Reference the section that follows 
entitled “Setting Up the Astro-Physics V2 ASCOM Driver”.

3.	 Install Sequence Generator Pro

4.	 Click the Sequencer Icon on the icon tab. 

5.	 In the Equipment options, find Telescope. From the Tel-
escope drop-down menu select “AstroPhysics GTO V2 
Mount”.  See image right.

6.	 Once you select it you can click the Gears icon to the 
right of the mount selection drop-down. This will show 
the AP V2 driver’s “Setup Telescope” window that you 
filled out earlier.   You can review it if you wish.  Then 
click “OK” and you are done.  

The Astro-Physics V2 ASCOM driver is a hub through which all third party ASCOM compliant software can be connected.  
Planetarium, camera control and focusing software, etc. can be connected to it and operated simultaneously.  

7.	 Place the system into a defined AP park position.  See the section, Pre-Defined Park Positions, at the end of this Quick 
Start Guide.

a)	 If you are setting up the mount afresh (as when you need to disassemble the mount each night), you will tell the 
mount to unpark from a specific numbered position (for example Park 3).

b)	 If you simply park the mount each night (in an observatory or at a multi-night star party), then you will always unpark 
from “Last Parked”.  This assumes that you have not loosened the clutches and moved the telescope via hands.

8.	 Power up the mount and then start SGP.  When SGP connects to the mount it will start the AP V2 driver which in term 
will launch APCC and initialize the mount. 

9.	 After finishing your night’s observing (or day’s solar observing) park the mount to your chosen Park position. 

10.	Disconnect your equipment in NINA and close any active software programs (the AP V2 driver will close automatically).  
Power down the mount.
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Video Tutorial: Using Sequence Generator Pro with APCC
Astro-Physics created a YouTube video on using Sequence Generator Pro with APCC software. This is a great step-by-
step tutorial starting with the basic setup, and moving on to other topics such as setting up meridian flip.

You can find this video on the Astro-Physics YouTube channel (https://www.youtube.com/@AstroPhysicsCorp) as well as a 
direct link here: https://youtu.be/hRNSlZpHCw8
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Workflow When Using Mobile Devices 

	● SkySafari™ for iOS and Android by Simulation Curriculum Corp – This software is offered through the Apple App 
Store. SkySafari does not use the ASCOM interface.  Mount initialization is performed when connection is made and 
the mount is unparked.

	● Luminos™ for iOS by Wobbleworks LLC – This software is offered through their 
internet website.  Luminos does not use the ASCOM interface.  Mount initialization is 
performed when connection is made and the mount is unparked.  

Mobile smart devices will all connect over WiFi.  The GTOCP4/5 ships out from the factory 
in Access Point mode which means that it will act as a hotspot for your smart device.  If you 
wish to have both the GTOCP4/ and Smart device go through a local area network, please 
see the information in the GTOCP4/5 manual.  For this quick guide, we present the simple 
direct connection where you select the GTOCP4/’s network as the host for your device.  

The screen shot to the right shows an iOS device running Sky Safari 5 Plus, but it 
generically illustrates what must be done for any device.

1.	 Open the device’s Settings page and then open the WiFi settings.

2.	 Find and then select the GTOCP4 network.  You will need the password: 
xxxadmin12345   where the xxx is the numeric portion of your GTOCP4/5’s serial num-
ber.

3.	 Position the scope.  See the section in the mount manual illustrating park positions.

a)	 SkySafari – Put the mount in a Park 4 position when using SkySafari (the only posi-
tion recognized by SkySafari at this time)

b)	 Luminos – Put the mount in any of the Astro-Physics park positions if using Luminos 
(or restart from Current Position if previously parked and unmoved).  

4.	 Open SkySafari or Luminos and enter settings for the Astro-Physics mounts.

a)	 Start SkySafari 5/6 - see image at right.

i)	 Click Settings at bottom of the screen.

ii)	 Scroll down to Telescope Setup and click.

iii)	 Scope Type: Astro-Physics

iv)	 Mount Type: Equatorial GoTo (German)

v)	 Enter IP Address: 172.31.0.1

vi)	 Enter Port Number:  23

vii)	Turn on Set Time & Location and then click Done.

b)	 Start Luminos - see image bottom right.

i)	 Click Observe at bottom of screen.

ii)	 Click Remote and then Configure.

iii)	 Protocol - select Astro-Physics and then click mount to go back.

iv)	 Connection - select WiFi serial device and then click mount to go back.

v)	 IP Address - click Edit at top and enter 172.31.0.1 as the IP address and 23 as 
the port; then click Done.

5.	 To Connect to the mount (initialization will take place).
a)	 SkySafari

i)	 Side scroll at bottom to Scope and click.



15

ii)	 Click Connect (mount must be in Park 4).

b)	 Luminos

i)	 Click Observe at bottom of screen.

ii)	 Click Remote Control and then the Connection slider.

iii)	 Scroll down and click Un-Park.

iv)	 Choose and click the correct Park Position.  Click Done..

6.	 After an evening enjoying the stellar marvels:

a)	 SkySafari

i)	 Click Disconnect.

ii)	 Choose either Park 4 Position to park mount, or Disconnect to leave unparked or Cancel.

b)	 Luminos

i)	 Click Observe at the bottom of the screen.

ii)	 Click Remote Control. 

iii)	 Scroll down to see Park and click it.

iv)	 Choose Park Position 1-4 or Current.

v)	 Scroll up and click the Connection slider to disconnect.  Click Done.

7.	 Power down the mount.  

Workflow When Using Devices Other than PCs 

Most Astronomy control software with which we are concerned is PC based and written to be ASCOM compliant.  However, 
this is not universally true.  There are some Mac- and Linux-based products that have developed their own drivers and 
there are also a few additional iPhone and Android products.  Reference the Software from Other Vendors section in the 
GTOCP4/5 Servo Manual.

Although these products will allow mount control, they may have limitations.  They are not able to take advantage of 
the many high precision, safety and enhanced functionality features that are available in the AP V2 ASCOM driver and 
especially in APCC. 

We do not have enough expertise with these Mac based products to feel confident to advise you and, thus, will refer you 
to the specific vender of the product.  If you experience problems, you will need to seek solutions through the appropriate 
vender.  

We can supply limited connection information for the Mobile Smart Devices previously described in order to get you 
started.  
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Setting Up the Astro-Physics V2 ASCOM Driver
One of the first things that must be done is to set up the Astro-Physics V2 ASCOM 
driver.  This is extremely important, as the settings that you enter will be used to 
initialize the mount once you power up and connect to the mount with your third 
party software.

Please note that the ASCOM Platform rules require that the AP V2 driver only be 
active when it is connected to from a third party ASCOM compliant software.  When 
disconnected, the AP V2 driver will automatically close. 

The photo at the right shows the Setup Telescope for the AP V2 driver.  It is here 
that you enter your settings.  Versions may vary slightly.  

Entering basic settings to get started

1.	 Mount Configuration.

a)	 Enter Mount type.

b)	 Enter GTOCPx Control Box model.

2.	 Mount Connection Details.

a)	 Drop Down Box (AP V2 driver used alone - APCC not used): 

i)	 Select COM Port (no APCC) from the drop-down menu if using USB or 
Serial cable connectivity (this is the default).  Then click the Find Mount 
button and the COM number should automatically be entered in the Port 
drop-down. 

ii)	 Select IP / Hostname (no APCC) from the drop-down menu if using 
Ethernet or Wireless connectivity (this is an optional choice).  Then enter the IP 
address or Host name in the window.

iii)	 Leave the Timeout and Retries in this window at default settings.  

b)	 Drop Down Box (AP V2 driver used with APCC): 

i)	 Select APCC REST API from the drop-down menu if you choose to use 
REST API as the connection method between the AP V2 ASCOM driver 
and APCC.  Then enter the IP address or Host name in the window. 

ii)	 (APCC Virtual COM Ports are no longer used or supported).  

3.	 Default Park / Unpark Positions

a)	 Unpark From - What you choose is dependent on whether you are permanent or 
portable.  

i)	 Portable and setting up each night - you will want to unpark from a reference 
Park position (default is Park 3) so that the mount is automatically oriented 
when initialized.   This will allow you to slew to your first object with reasonable 
accuracy and only require a simple centering of the object and a ReCal (Sync).

ii)	 Permanent setups (observatory or week-long star parties) - You will want to unpark from a reference Park 
position when first setting up (or if you have moved the telescope by loosening the clutch knobs and using your 
hands).  At the end of the evening you will park to a reference Park position.  Subsequently, you will unpark from 
Last Parked, which will initialize the mount with precise position 
and time agreement to your computer.

b)	 Park To - Will be chosen based upon convenience and personal pref-
erence.  For example, covering your scope at a star party is usually 
best done at Park 3; however, mounting and removing your scope is 
probably easier from a Park 2 position.   
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4.	 Site Setup

a)	 Click the “New” button and enter a site name.

b)	 Enter the Latitude and Longitude in degrees, minutes and seconds by click-
ing in the appropriate box each time (don’t forget the N/S and E/W boxes).  
Then enter the Elevation in meters.

c)	 Click the Save button to retain the site.  You can enter multiple locations for 
future use. 

Click the Advanced / Shrink Button in the lower right corner of the AP V2 
driver Setup Telescope.  See image below right.  

5.	 Initialization Setup - Check all the boxes in the top right window.

a)	 Sync Mount to PC Time.
b)	 Set Latitude / Longitude - default is to leave it checked.
c)	 Enable Mount Tracking on Unpark - under normal circumstances this is usually checked; however, if you like to 

power up the mount and go have dinner and watch a movie, then you may want to uncheck the box.  
d)	 Set Slew Rate - Assuming that you are not in a rush, this is usually set to 900x.
e)	 Set PulseGuide / Guide Rate - This is set to 1.00x and cannot be changed. 
f)	 Set PEM - Enable / Disable  The default is set to Enable PEM.  If your mount is more than a year or two old and you 

have not made a new curve, then it should be set 
to Disable PEM until you can create a new curve.   

g)	 Set RA Backlash (not visible with CP4/5) - always 
set to Zero correction. 

h)	 Set Dec Backlash (not visible with CP4/5) - al-
ways set to Zero correction.

i)	 Connect Time Out - use default settings.

6.	 Other Options

a)	 In general, use the default settings unless you 
have a specific reason to change it.

b)	 Enable Debug Logs - Checked.
c)	 Keep Mount Time Synced to PC Time - Checked.
d)	 Convert Syncs to ReCals - Checked.
e)	 Minimize Control Window on Connect - Unchecked.
f)	 Show in Taskbar when Minimized - Checked.
g)	 Check for New Version when Starting - Checked.
h)	 Auto-enable Tracking when ASCOM Clients Send cer-

tain Commands - Checked.
i)	 Calibrate Move Directions on First Slew - Checked if 

NOT using APCC.  
j)	 ASCOM RA MoveAxis = 0 Stops Tracking - Unchecked.
k)	 Set Driver Window on Top - Unchecked.
l)	 Remember Last Window Position - Checked.
m)	 Reverse Dec moves on pier flip - Unchecked.

Important:  Check for new versions of drivers and software frequently.  This will help your software to 
remain bug free and keep your equipment safe from unwanted surprises!

Advanced / ShrinkButton

Advanced / ShrinkButton
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Setting Up Astro-Physics Command Center (APCC)
 
The Astro-Physics Command Center (APCC) adds precision, safety, and functionality to the control system of your mount. 
APCC and ASCOM V2 act as a serial hub for all third party applications to access and control your mount.  It takes remote 
operation to the next level with safety and convenience that you won’t want to be without. 

APCC takes its place as the final arbiter between all of your software and the mount.  It is the program to which the mount 
directly connects, and everything else connects through APCC via ASCOM V2 driver.  It was designed from the beginning 
to integrate perfectly with the AP V2 ASCOM Driver.   APCC connects directly to the mount via USB, Serial, Ethernet or 
WiFi.

When APCC is used, it is the master for mount initialization and shut-down controls.  It should be the first piece of mount 
related software that is opened, and the last one that is shut down.  

Important note:  In previous versions of APCC, virtual port connectivity with the AP V2 ASCOM driver was used; however, 
issues sometimes occurred with a few computer brands and/or Windows versions.  We have switched to the use of a 
ReST API interface to correct these issues and strongly recommend its use going forward.  Refer to the APCC Help 
Manual for information on virtual port use. 

Some APCC Thoughts
	● APCC launches first.

	● It connects directly to the mount on its physical interface: RS232, USB, Ethernet or WiFi.

	● ReST API is the only interface for connection to the AP V2 ASCOM driver.

	● The AP V2 ASCOM Driver connects to APCC and acts as a hub.  The AP V2 driver is that to which your third-party 
software connects (“AstroPhysics GTO V2 Driver”).  The AP V2 driver starts automatically when your third-party 
software connects.  

APCC can be as simple or as complex as you wish to make it.  This Quick Start guide will only touch 
upon the Setup of this software.  The Help menu (and its Quick Start Guide) will provide more detailed 
information.  Don’t forget to click the “?” in the corners for specific information in that window!  

APCC Setup
1.	 Program Operation window suggested initial settings 

a)	 Ask if Ok to exit - Unchecked.

b)	 Keep APCC on top - Unchecked.

c)	 Show Emergency Stop window - Checked.

d)	 Clear all errors when starting and connecting to the mount - Checked. 

2.	 Advanced Settings (click Advanced Settings button).

a)	 Auto Initialize (secs) - Check & set to “0”.

b)	 Auto Shutdown (secs) - Unchecked.

c)	 Enable Login (to disk) - Checked.

d)	 Purge old logs on startup - Checked & set to “30”. 

e)	 Show Status Window when starting - Unchecked.

f)	 Enable Tracking Rate Tweak Window - Unchecked.

g)	 Prevent errant RECALs - Checked.

h)	 Keep mount time synced to PC Time (enabling will override the ASCOM V2 
driver’s setting) - Checked. 
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i)	 Click ASCOM Driver tab at top of window. 

i)	 ReST API radio button should be highlighted and the drop-down 
should read”60001” (these are both default values). 

3.	 Edit Initialize Mount Settings window (choose from Settings in the 
Menu Bar).

a)	 Initialization Site and Unpark will fill in automatically from the other 
tabs.

b)	 Optional Initialization (all boxes checked)

i)	 Set Tracking Rate - Sidereal.

ii)	 Set Slew Rate - 900x.

iii)	 Set Dec. and R.A. Backlash - Check “0” (these options only show 
up when using the CP3).

iv)	 Set PEM (Non-Encoder Only) - The default is set to Enable PEM.  If your mount is more than a year or two old 
and you have not made a new curve, then it should be set 
to Disable PEM.

4.	 Site Tab - Site Information (should agree with AP V2 driver).

a)	 Click “Manage Sites” button.

b)	 Click New button and create a named site.

c)	 Enter Latitude and Longitude (and check that the N-S and 
W-E radio buttons are correct). 

d)	 Click Time Offset button (at right) and choose time zone.

e)	 Enter Elevation in meters (after checking the Metric box).

f)	 Set default Temp (approximate) and Pressure. 

g)	 Click Save button and close.

5.	 Connection  

a)	 Set USB/Serial in drop-down (default). 

b)	 Click Find Mount button (mount must be powered up and con-
nected via a USB or Serial cable). 

c)	 COM port number from Find Mount will be confirmed and then 
should automatically be entered in the Primary Port drop-
down. 

d)	 Click the Config Driver button - this will optimize the ASCOM 
V2 driver configuration.  

Important Notes: 
Complete connection information is found in the “Getting Started” section of the PDF manual for APCC found at the 
following link:  http://www.astro-physics.com/tech_support/apcc/apcc-pro.pdf   
 
The CP4/5 uses an industrialized and self-powered USB connector and its robustness will only be limited by the USB of 
your computer (the weak link).  Avoid using USB hubs which can reduce reliability.  If you must use a hub, then buy a high 
quality, powered hub.   
 
Reference the APCC Help file by clicking the “?” for additional information that is beyond the scope of this Quick 
Start Guide.
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Keeping Your Keypad and PC in Harmony
There may come a time in a future iteration of the Keypad firmware when the Keypad and your PC will communicate with 
each other and share information.  At this time they do not.  Consequently, there are some rules that need to be observed.  

	● The Keypad and the PC do not talk to each other.  When doing a GoTo the Keypad and the PC do not know to 
which object the other has slewed.  Therefore, you must always sync (ReCal) from the device that initiated the slew.   
 
When either the Keypad or the PC issue a GoTo, the object’s coordinates are sent to the CPx control box which knows 
the current coordinates where the mount is pointing.  It then calculates how much each motor needs to turn to get to 
the new GoTo coordinates.  These are strictly mathematical calculations.   
 
Both the Keypad and the PC can read the current coordinates from the CPx, but the opposing device can not know to 
which object the mount was sent (it would simply be syncing on the last GoTo coordinates that IT sent to the mount).  
You can only sync using the device that issued the latest GoTo.  
 
However, once you send the mount to an object you can then center the object with the opposing device by doing N-S-
E-W button moves.   The pointing coordinates in the GTOCPx will change by the amount of the button adjustments 
you make, but then syncing WITH THE DEVICE THAT ISSUED THE GOTO SLEW will restore the coordinates to 
those requested by the GoTo slew command.    

	● Set the Keypad to AutoConnect: EXT.  If you are using a computer along with the Keypad, it is important set the 
Keypad to AutoConnect: EXT.  When powering up the mount using this mode the Keypad will wait for the computer to 
initialize the mount.  Once the computer has initialized the time and location information the Keypad will advance to 
the main menu screen.  This is the preferred procedure when using both control devices, as it assumes the computer’s 
priority status.    
 
If a computer is not available, you can easily push the Menu button on the Keypad and then walk through the Keypad 
initialization process.  

	● Park the mount using the device that provided the initialization.  Another rule to follow is to park the mount using 
the device that did the initialization.  The primary reason for this is that there may be a difference in time between the 
computer clock and the Keypad clock.  This will affect GoTo and meridian flip accuracy.  In a worse case, a scope/
counterweights orientation error can occur and send the scope slewing into the pier upon the first GoTo slew.  

	● Review the Keypad manual.  The Keypad manual provides a wealth of detailed information.  Even if you do not own 
a Keypad, you will find very useful information in the manual which is available in PDF format on the Technical Support 
page of our web site. 
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Some Important Notes 

	● When using Mounts with Auto-Adjust Motor Gearboxes: 

	○ Use the clutches when repositioning the mount!  This is a safer practice than using the gearbox 
disengagement lever in order to ensure that the gear teeth are not damaged by accident.  Refer to your 
manual for clutch operation. 

	○ Begin your balance procedure in Park 3 position (pointing to the pole).  This will ensure that an out of 
balance scope does not have a sudden, wild swing that could damage the scope, the mount or you!  

	○ Be sure that the Gearbox engage/disengage lever is fully disengaged and that the worm is 
fully separated from the worm wheel when balancing the mount (or moving the mount when 
repositioning)!  It is important not to damage the tops of the gears by bumping the worm and worm wheel 
teeth!

	● Be careful not to twist and inadvertently damage internal cables.  It is important to remember not to twist and 
damage internal cables by over-rotating the axes.  If the axes are rotated when setting up or performing mount 
maintenance, you will need to undo the axis rotation to return cables to their normal position.  Internal cables should 
not be pulled tight; rather, they should be left slack and free to move. 

	● Be sure that all fasteners on the mount and scope are tight.  You do not want to have to catch a falling scope or 
see it sitting unexpectedly on the concrete!  

	● Computer and Keypad use together.  If you are using a computer for primary mount control, but wish to have 
the Keypad connected for convenience while at an eyepiece, then set the Keypad to AutoConnect: EXT so that the 
computer will initialize the mount, not the Keypad.  

	● Always Initialize and park the mount using the same device.  If you initialize with the Keypad, then park with the 
Keypad...if you initialize with the computer, then park with the computer.  (Important Note:  If the Keypad is your 
chosen method of operation, then uncheck the following two boxes in the AP V2 driver’s  Setup Telescope...1- Sync 
Mount to PC Time and 2- Keep Mount Time Synced to PC Time.)  

	● Unpark from Last Parked.  If the mount is being re-started from a previous night, as in a permanent observatory or at 
a week-long star party, then unpark from Last Parked (assuming that the scope has not been repositioned manually by 
hand via the clutches since it was last parked).  

	● Unpark from a defined park position.  If your equipment is being set up afresh for a night’s observing, then place 
the scope in a defined park position and have it unpark from that specific position.  If it is to remain set up for the next 
night, then park it to your position of choice and resume from Last Parked the next night. 

	● GTOCP4/5 Control Box will auto-park mount when powered off.  The GTOCP4/5 control box will auto-park the 
mount in place when the power is turned off or is interrupted.  Nevertheless, we do recommend parking the mount to a 
defined park position when finishing the evening’s viewing (and leaving the mount set up for another night).

	● Use the mount with its own power supply.  For best performance the mount should have its own dedicated power 
supply separate from other powered equipment.  This is especially true when imaging.

	● Reference the Astro-Physics Technical Support page of the website.  There is a wealth of information on the 
Technical Support page that can often answer the questions that you have, as well as provide in-depth understanding 
and fixes.  All the latest versions of the manuals can be found on the page.  

	● Remember that the answer to most questions can be found in the supplied manuals or on the website.  Please 
reference these manuals or the website Technical Support before calling Astro-Physics.  If you cannot find the answer, 
then the Technical Support team is ready to help.  

Please take special notice:
	● Outdoor Storage – If you have a mount that is left outside for extended periods covered by a tarp or scope cover, 

then it is highly recommended to remove the GTOCP4 and Keypad and take them inside to a safer environment.  
Tarps and covers cause significant condensation build up unless steps are taken to mediate the problem.  Often low 
wattage light bulbs or fans are used to reduce condensation for short term storage, but this is no guaranty.  

	● VERY IMPORTANT:  We take every precaution to make our control boxes moisture and dew resistant; however, 
they are not waterproof!  We cannot be responsible for water damage when reasonable care has not been taken to 
shield them from rain, excessive dew, or when storing them outside under tarps for extended periods.  
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Assemble Mount

Handy Tools to Have on Hand

In Your Accessory or Tool Box: 
	● Small torpedo level to level your scope when using the handy reference park positions, particularly if you use the 

daytime polar alignment routine outlined in your Keypad manual.

	● Compass - Don’t forget to know your magnetic offset when using a compass (there can be a large difference). 

	● Documentation – Physical copies of your mount, control box and keypad (if you have one) manuals as well as any 
other documentation that you received with your mount (or control box) or that you find in the Technical Support 
section of our website that may be useful. 

On Your Smart Phone:
For the utmost of convenience, the following items can be downloaded to your smart phone, which you are likely carry with 
you everywhere.

	● App(s) that allow your phone to be used as a level, inclinometer and compass.  If using a compass app, make sure to 
set it to use “True North”. 

	● PS Align Pro App – The longitude and latitude of your current site will display, along with an option to set the reticle to 
the RAPAS.  Apps are available for iOS and Android.

	● Download PDFs of all relevant and recent documents from the Technical Support Section of our website or you can 
link to our website if you have service at your observing site. 

Let’s Get Set to Have Some Fun
1.	 Place mount on pier or tripod

This is fairly fundamental and will depend on the mount that you are using and your choice of pier or tripod.  If you are 
using a pier of your own construction, please be sure that it is robust and does not downgrade the performance of your 
Astro-Physics mount.  We recommend these minimums:

	● 6” pier for the Mach1GTO or Mach2GTO

	● 8” pier for the 1100GTO

	● 10” pier for the 1600GTO

Pier strength and non-flexure is based on pier diameter, not wall thickness.

2.	 Connect cabling and power 
 
Please reference the manual which came with your mount for specifics.   Note that all our up-to-date manuals can be 
found in PDF form on the Technical Support page of our website.  

3.	 Load counterweights onto mount 
 
This may seem like a no-brainer, but it is all to easy when rushing to get set up for the evening to forget and put the 
scope on the mount before the counterweights... this can have VERY bad consequences!

4.	 Attach scope to mount 
 
Ok...now we can put the scope on the mount, along with finder, diagonals, eyepieces and cameras.  Having everything 
on the scope before doing the balancing is important. 
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Balancing
Balancing your scope can seem like a simple operation. However, some care must be taken to prevent injury and damage.  
When beginning the balance process your scope may be considerably out-of-balance.  In order to prevent a wild swing that 
could scrape and damage the worm wheel’s gear teeth or a painful collision to one’s person you should head the following 
steps.

Start with the counterweights at the bottom of the counterweight shaft and scope in Park 3 position.

	● Balance Dec Axis First (i.e., balance the telescope) - Place the scope into a Park 3 position before beginning the 
balance process.  Do this by loosening the clutches and moving the scope by hand.  This will provide a feel for 
preliminary adjustment. 

	○ Using only the loosened Dec Axis clutches, rotate the scope horizontally and do a rough balance by placing 
a hand on either side of the scope and with a back and forth motion with your hands feel for the proper 
balance. 

	○ Place the scope back into Park 3 position and tighten the clutches.  Now disengage the motor box using the 
Lever Assembly.  With the motor box fully disengaged bring the scope into a horizontal position and adjust 
the balance.  Return the scope to Park 3 and re-engage the Lever Assembly.

	● Balance RA axis Second (i.e., balance the counterweights) - Similar to the procedure above, loosen the R.A. 
clutches and carefully rotate the axis to have a preliminary feel for balance adjustment.  

	○ Using only the loosened clutches to gauge balance, slide the heaviest weight all the way to the top of the 
shaft and see if the balance is still counterweight heavy.  If so, then slide the next heaviest weight all the way 
up.  If not, then you should add a counterweight.  You will want to have the heaviest and most of the weights 
at or near the top of the shaft.  The adjustment should be done with the a smaller weight.  The reason for this 
is to minimize Inertial Moment Arm.

	○ Once you have achieved a near balance, place the scope in the Park 3 position and tighten the clutches.  
Now fully disengage the motor box using the Lever Assembly and perform a precise balance.  Again, return 
to the Park 3 position and re-engage the Lever Assembly.  

30 lb.
10 lb.

30 lb.
30 lb.

30 lb.

30 lb.

30 lb.
10 lb.

No Yes

Add

�ne
balance
adjust

Optimizing Balance
Both examples provide balance, but the example to the left will
experience a huge inertial moment arm.  The examples on the

following page will show the calculations.

30 lb.

30 lb.

10 lb.

10 lb.

1 foot

3.0 feet

3.0 feet

1 foot

In Balance at 1 ft. x 30 lb. =    30 ft-lb.

In Balance at 3.0 ft. x 10 lb. = .   30 ft-lb.

Inertial Moment (1 ft.)² x 30 lb. = .  30 ft²-lb.

Inertial Moment (3.0 ft.) x 10 lb. = 90 ft²-lb.²

BALANCE

INERTIAL  MOMENT  ARM

Why More Weight Higher Up the Shaft is Better!

No Difference

HUGE Difference
Distance is squared!

Inertial Moment is TRIPLED!

No

Yes
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Polar Align Mount
 
Polar alignment is a necessary first step for all German equatorial mounts.  You will want to get the mount roughly polar 
aligned and level before following one of the methods below.  This will get you up and running and enjoying your mount.  If 
you enter the realm of astro-imaging, then you will want to refine your alignment.  The mount manual will describe in more 
detail several  procedures.  

You may also want to review the highly refined (and yet simple) “Drift Alignment R.A. Correction Method” described on the 
Technical Support page of our website under “General Information that Applies to all German Equatorial Mounts”.

Tools
	● Torpedo or Bubble Level
	● Compass corrected for magnetic declination
	● Smart phone Apps for the above (compass app preference set to “True North”)

Methods
1.	 Right-Angle Polar Alignment Scope (RAPAS) 

 
Using our highly accurate, neck-friendly Right-Angle Polar 
Alignment Scope will provide adequate polar alignment 
accuracy needed for visual observing.  As an imager, if you 
make the one-time R.A. rear plate adjustment as described 
in the RAPAS instructions, then you will be able to start imag-
ing immediately after aligning with the RAPAS.  Long focal 
length scopes may benefit from further refinement of polar 
alignment.  This polar scope is designed for both Northern 
and Southern Hemispheres.  See example photo at right with 
Mach1GTO.  Complete instructions for the RAPAS are found 
on the technical support page of our website under “Mount 
Accessories / Instructions”.

2.	 Daytime Alignment  
 
Please Note: We’ve added a video tutorial on daytime polar alignment to our YouTube channel at https://www.youtube.
com/watch?v=agYVfehV2JM. Please check out our channel at https://www.youtube.com/@AstroPhysicsCorp.  
 
Use the Park 1, Park 4 or Park 5 position (along with Park 2) to polar align your telescope in the daytime or when 
Polaris is not visible.  Note that Park 5 is our recommended “horizontal” park position.  Park 1 is only seconds away 
from tracking into a counterweight up status.  Complete instructions for the Daytime Alignment Method are found in the 
Keypad Manual on the technical support site of our website.    
 
This is a great method in these situations:

a)	 Solar observing.

b)	 Observe planets and stars during the day...it’ll amaze your friends!

c)	 Get a head start at a star party or observing site without wasting any of the night.

3.	 Drift Alignment R.A. Correction Method 
 
Please see the Technical Support page of our website for the instructions to this alignment technique ( http://www.
astro-physics.com/tech_support/mounts/Drift_Alignment_RA_Correction_Method.pdf ).  This will provide the highest 
precision of polar alignment with the least amount of drift within 45 degrees of the zenith (where most imaging is done).  
It is easiest with the use of a CCD camera and camera control software that can create a guiding graph; however, it can 
also be done using a reticle eyepiece (using with a Barlow for more accuracy) provided that you orient the reticle to the 
R.A. and Dec. axes and know which is which. 

Polar Axis

Housing

Polar Scope
Adapter

Rotate
Focus
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Pre-defined Park Positions (NORTHERN & SOUTHERN HEMISPHERES)

When first setting up the mount in a new location it is recommended to loosen the clutches and, using your hands, position 
the mount into one of these five Reference Park Positions.  You will then tighten the clutches and power up the mount.  

Recommended:  Park 3 is a safe and balanced position.  Park 5 is a safe, low profile position with minimum 
cable twisting. We no longer recommend using Park 1 position.

Keypad:  Choose “New Setup” and “Start from Park Position” from that specific position.   
Computer:  Set the AP V2 driver to resume from that specific position and connect your software to the mount.  

When the connection is made the mount will be properly initialized with time, location and orientation information.  It will be 
ready to go to your first object. 

The scope is level on the west side of 
the mount, facing the northern horizon.  
The counterweight shaft is also level 
and pointing due east.     

Both Hemispheres:   RA is horizontal, 
North: Dec = (90-Latitude)   South: Dec = (-90-Latitude)

The southern hemisphere is mirror reversed.  The 
scope is still level on the west side of the mount, but 
is facing the southern horizon.  
The counterweight
shaft is also still
level and pointing due east.

PARK 1

Northern
Hemisphere

Southern Hemisphere

WARNING!
If you want a park position that can be accurately 

leveled, we recommend Park 5.

The scope is level on top
of the mount facing the 
eastern horizon.   The 
counterweight shaft is
pointing down.

Both Hemispheres:   RA axis is vertical,  Dec = 0

The southern hemisphere
is mirror reversed.  
The scope still points
to the eastern horizon,
but east is to the left
when facing the southern pole.

PARK 2
Northern
Hemisphere

Southern
Hemisphere

The scope is pointing to
the pole.   The counterweight
shaft is pointing down.

RA axis is vertical, Dec = 90

PARK 3

Northern
Hemisphere

&
Southern

Hemisphere
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The scope is level on the east side of 
the mount, facing the northern horizon.  
The counterweight shaft is also level 
and pointing due west.    

Both Hemispheres:   RA is horizontal, 
North: Dec = (90-Latitude)   South: Dec = (-90-Latitude)

The southern hemisphere is mirror reversed.  The 
scope is still level on the east side of the mount, but 
is facing the southern horizon.  
The counterweight
shaft is also level and
pointing due west.

PARK 5

Northern
Hemisphere

Southern Hemisphere

PARK 4

Northern
Hemisphere

Southern Hemisphere

The scope is level on
the east side of the                     mount, facing the 
southern horizon.                          The counterweight 
shaft is also level                            and pointing due 
west.    

Both Hemispheres:   RA is horizontal, 
North: Dec = (-90+Latitude) South: Dec = (90+Latitude)

The southern hemisphere is mirror reversed.  The 
scope is still level on the east
side of the mount, but
is facing the northern
horizon. The counter-
weight shaft is also still
level and pointing due west.
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Additional Resources
This Quickstart guide will get you through basic setup, but this is just the start of your journey. Here is a list of additional 
resources that most mount owners find extremely helpful:

	● Astro-Physics YouTube channel - with tutorial videos: https://www.youtube.com/@AstroPhysicsCorp 

	● Astro-Physics Knowledgebase - Our knowledgebase offers a large number of searchable articles on answers to 
common questions and troubleshooting. It is a great resource if you run into any questions or hiccups setting up or 
using your Astro-Physics mount. https://astro-physics.bolddesk.com/kb

	● The Astro-Physics GTO User Group - We highly recommend you join this user group. It is intended as a friendly 
place where other mount owners have constructive discussions of their equipment, share tips, make suggestions and 
help each other. Astro-Physics staff moderate and participate in these discussions as well. https://ap-gto.groups.io/g/
main
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